Oracle 10g ODBC Installation Guide

Voyager 7.2.1
CONFIDENTIAL INFORMATION

The information herein is the property of Ex Libris Ltd. or its affiliates and any misuse or abuse will result in economic loss. DO NOT COPY UNLESS YOU HAVE BEEN GIVEN SPECIFIC WRITTEN AUTHORIZATION FROM EX LIBRIS LTD.

This document is provided for limited and restricted purposes in accordance with a binding contract with Ex Libris Ltd. or an affiliate. The information herein includes trade secrets and is confidential.

DISCLAIMER

The information in this document will be subject to periodic change and updating. Please confirm that you have the most current documentation. There are no warranties of any kind, express or implied, provided in this documentation, other than those expressly agreed upon in the applicable Ex Libris contract. This information is provided AS IS. Unless otherwise agreed, Ex Libris shall not be liable for any damages for use of this document, including, without limitation, consequential, punitive, indirect or direct damages.

Any references in this document to third-party material (including third-party Web sites) are provided for convenience only and do not in any manner serve as an endorsement of that third-party material or those Web sites. The third-party materials are not part of the materials for this Ex Libris product and Ex Libris has no liability for such materials.

TRADEMARKS

"Ex Libris," the Ex Libris bridge, Primo, Aleph, Alephino, Voyager, SFX, MetaLib, Verde, DigiTool, Preservation, URM, ENCompass, Endeavor eZConnect, WebVoyáge, Citation Server, LinkFinder and LinkFinder Plus, and other marks are trademarks or registered trademarks of Ex Libris Ltd. or its affiliates.

The absence of a name or logo in this list does not constitute a waiver of any and all intellectual property rights that Ex Libris Ltd. or its affiliates have established in any of its products, features, or service names or logos.

Trademarks of various third-party products, which may include the following, are referenced in this documentation. Ex Libris does not claim any rights in these trademarks. Use of these marks does not imply endorsement by Ex Libris of these third-party products, or endorsement by these third parties of Ex Libris products.

Oracle is a registered trademark of Oracle Corporation.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through X/Open Company Ltd.

Microsoft, the Microsoft logo, MS, MS-DOS, Microsoft PowerPoint, Visual Basic, Visual C++, Win32,

Microsoft Windows, the Windows logo, Microsoft Notepad, Microsoft Windows Explorer, Microsoft Internet Explorer, and Windows NT are registered trademarks and ActiveX is a trademark of the Microsoft Corporation in the United States and/or other countries.

Unicode and the Unicode logo are registered trademarks of Unicode, Inc.

Google is a registered trademark of Google, Inc.
# Table of Contents

Updates to This Guide

Chapter 1 **Introduction**

About This Guide

*Automation Tool*

*Microsoft XP, Vista, or Windows 7*

Before You Start

Terminology

Why All the Reboots?

Chapter 2 **Downloading the Installation Packages**

Before You Start

*Confirm Disk Space*

*Directories*

Downloading

Extracting

Chapter 3 **Backing Up the Current Oracle Configuration**

Backing Up

Chapter 4 **Uninstalling Previous Versions of Oracle**

Removing a Previous Version

Chapter 5 **Installing Oracle 10g - XP/Vista**

Installing Oracle 10g for XP/Vista

Chapter 6 **Installing Oracle 10g - Windows 7**

Installing Oracle 10g for Windows 7

Chapter 7 **Configuring Oracle**

Before You Start

Upgrade Instructions

New Installation Instructions

Completing the Configuration

Chapter 8 **Prepackaged Reports**

Before You Start

Linking Prepackaged Reports
Chapter 9  Troubleshooting................................................................. 49
            First Steps................................................................................. 49
            Error Codes.............................................................................. 50
            Other Possible Errors ............................................................... 51
Updates to This Guide

This guide contains the following updates:

- Updated the **Downloading** section on page 11.
- Updated the guide format (headers and so forth)
Introduction

This section includes:
- About This Guide on page 7
- Before You Start on page 8
- Terminology on page 9
- Why All the Reboots? on page 9

About This Guide

The purpose of this guide is to provide direction for the following components of the Oracle 10g ODBC installation:

- Preinstallation considerations
  See Before You Start on page 8, Terminology on page 9, and Why All the Reboots? on page 9.
- Downloading the Installation Packages
- Running the Ex Libris automation tool (BEAT)
  See Automation Tool on page 8 for details about the tool.
- Backing Up the Current Oracle Configuration
- Uninstalling Previous Versions of Oracle
- Installing Oracle 10g - XP/Vista or Installing Oracle 10g - Windows 7
- Configuring Oracle
- Prepackaged Reports
- Troubleshooting
Automation Tool

To simplify completing your installation, Ex Libris designed a tool to automate as much of the process as feasible. The following .bat files are provided for running the automated installation process:

- BEAT.bat
  (Microsoft Windows XP version from the package download 10201_client_win32.zip)
- BEAT.bat
  (Microsoft Windows Vista version from the package download 10203_client_vista-win7.zip)
- BEAT-win7.bat
  (Microsoft Windows 7 version from the package download 10203_client_vista-win7.zip)

Specifically with the Microsoft Windows 7 version of the automated tool, you may need to perform some manual steps. The instructions in Installing Oracle 10g - Windows 7 on page 23 guide you through using the automated tool, performing the manual steps, and returning to the tool to complete your installation.

Microsoft XP, Vista, or Windows 7

The installation instructions are divided by operating system environment. For Microsoft XP and Microsoft Vista, see Installing Oracle 10g - XP/Vista on page 21; and for Microsoft Windows 7, see Installing Oracle 10g - Windows 7 on page 23.

Before You Start

- If you run into problems at any point, stop and seek assistance from Ex Libris Global Customer Support.
- The Oracle 10g client replaces any pre-existing client and is backwards compatible with Oracle 8i and Oracle 9i servers.
- Make sure your Windows logon has local administrator rights before you begin. Your IT department can assist you if you are unsure or do not have local administrator rights.
- Once the uninstall process has started, do not leave it unattended or start working on a different application until you have completed the process. Doing either may cause the application to freeze and require a reboot to resolve any problem. Rebooting at the wrong time could greatly complicate the uninstall process.
- Shut down all other applications. Temporarily, disable any PC firewall and virus software before running the applications.
- If you are running Norton AntiVirus 2006 or later, ODBC linking does not work by default. Read Microsoft’s knowledge base article 329820 for help. Otherwise, consult with your IT department.
- The Ex Libris automation tool (BEAT.bat or BEAT-win7.bat) is designed and tested for use with Voyager.
- If you have other Ex Libris applications, contact Ex Libris Global Customer Support for assistance.
- If you have non-Ex Libris applications that use ODBC, check with your IT department before proceeding.
- If this is a new installation of the ODBC drivers, you can skip Backing Up the Current Oracle Configuration that starts on page 13 and Uninstalling Previous Versions of Oracle that starts on page 17.

**Terminology**

- You may read or hear a reference to a driver CD. Years ago, the ODBC drivers were shipped out on a CD, but the prevalence of high-bandwidth network connections has made CD distribution obsolete.
- You can burn the contents of the downloaded zip file to a CD for archival purposes or for intra-library installation.
- If persistent network issues prevent you from downloading the zip file, you can request a physical CD from Ex Libris. Specify the Windows version you need.

**Why All the Reboots?**

For a cleaner and faster uninstall (and install) process, rebooting the PC:
- Just before critical work helps minimize services competing for system resources.
- And then shutting down all the other programs minimizes program fragments and memory leaks.
- After making registry changes ensures that the link between PC files and the previous registry data no longer exists.
2

Downloading the Installation Packages

This section includes:
- Before You Start on page 11
- Downloading on page 11
- Extracting on page 12

Before You Start

Confirm Disk Space

The download requires 500MB of free space.
The installation requires an additional 500MB of free space.

Directories

Create a directory such as C:\Oracle10g on your PC to which you can extract the package.

Downloading

The packages available for download can be accessed from the Ex Libris FTP server (downloads.exlibrisgroup.com). You need the odbc password, which can be obtained from the eService knowledge base.

The package you need to download is determined by your operating system environment. For Microsoft XP, download the 10201_client_win32.zip package. For Microsoft Vista and Microsoft Windows 7, download the 10203_client_vista-win7.zip package.
**Extracting**

Extract the downloaded file to the directory you created.

- The WinZip software is commonly used for this process.
- Check with your IT department if you are unsure which program to use.

Ensure you preserve the folder names when you extract the file.

- In WinZip, select the Use folder names option.
- Check with your IT department or software vendor if using other software.

The Oracle 10g ODBC package is ready to install.
Backing Up the Current Oracle Configuration

This section includes:
- Backing Up on page 13

NOTE:
The Oracle backup configuration step should only be run if there is already a working Voyager ODBC configuration. If your PC has never had Oracle ODBC drivers on it, you can skip to Installing Oracle 10g - XP/Vista on page 21 or Installing Oracle 10g - Windows 7 on page 23.

Backing Up

To back up your current Oracle configuration:

1. Restart your computer.
2. Log on to the PC and ensure that there are no open programs.
3. Start the Ex Libris automation tool.
   - BEAT.bat located in C:\Oracle10g\10201_client_win32 (Microsoft XP)
   - BEAT.bat located in C:\Oracle10g\10203_client_vista-win7 (Microsoft Vista)
   - BEAT-win7.bat located in C:\Oracle10g\10203_client_vista-win7 (Microsoft Windows 7)

For the Microsoft Windows 7 environment only, run the BEAT tool as Administrator from the command line as follows:

a. Click Start > All Programs > Accessories > Command Prompt.
b. Right click Command Prompt.
c  Click **Run as administrator**.

The command line window opens.

d  Change the directory (cd) to the location of the unzipped files, specifically, the location of the `BEAT-win7.bat` file.

```
C:\WINDOWS\system32\command.com
Microsoft (R) Windows DOS
(C)Copyright Microsoft Corp 1990-2001.
U:\>cd c:\Oracle10g\10203_client_vista-win7
```

e  Run `BEAT-win7.bat` from the command line.

**IMPORTANT:**

Using this method to run BEAT in the Windows 7 environment is necessary to insure that the BEAT tool is able to access all the files that it needs.

4  Back up `TNSNAMES.ORA` with **option 1, Backup 9i tnsnames.ora**.

```
Brian's ExLibris Automation Tools (BEAT) - Oracle Client Configurator
1. Backup 9i tnsnames.ora
2. Remove Oracle 9i Client
3. Install Oracle 10i Client
4. Update tnsnames.ora
5. Update ODBC Configuration
6. Quit
Please Make a Selection: _
```

Notepad opens to display the `tnsnames.ora` file.
5 Compare your tnsnames.ora file with the file in the above illustration.
   - If your file and the above illustration look similar, close Notepad.
   - If your file is blank or significantly different from the above illustration, stop and contact Ex Libris Global Customer Support before proceeding.

6 Press any key to return to the Ex Libris automation tool.
   The Oracle ODBC configuration is now backed up.
Uninstalling Previous Versions of Oracle

Removing a Previous Version

To remove the previous version of your current Oracle client:

1. Restart your computer.
2. Log on to the PC and ensure that there are no open programs.
3. Start the Ex Libris automation tool.
   - **BEAT.bat** located in C:\Oracle10g\10201_client_win32 (Microsoft XP)
   - **BEAT.bat** located in C:\Oracle10g\10203_client_vista-win7 (Microsoft Vista)
   - **BEAT-win7.bat** located in C:\Oracle10g\10203_client_vista-win7 (Microsoft Windows 7)

For the Microsoft Windows 7 environment only, run the BEAT tool as Administrator from the command line as follows:

a. Click **Start > All Programs > Accessories > Command Prompt**.

b. Right click **Command Prompt**.

c. Click **Run as administrator**.
   
The command line window opens.

d. Change the directory (cd) to the location of the unzipped files, specifically, the location of the **BEAT-win7.bat** file.
Chapter 4: Uninstalling Previous Versions of Oracle

Oracle 10g ODBC Installation Guide

Figure 4: Run BEAT-win7.bat from the command line.

**IMPORTANT:** Using this method to run BEAT in the Windows 7 environment is necessary to insure that the BEAT tool is able to access all the files that it needs.

4 Remove Oracle clients.
   a Select option 2, Remove Oracle 9i Client.

   ![BEAT-win7.bat command line output]

   You are prompted to **Press any key to continue.**

   **CAUTION:** Do not press any key.

   b Type remove and press **Enter.**
c. Enter Y and press Enter if you are sure you want to remove all existing Oracle clients.

You see a number of errors on the screen. These are normal and can be ignored.

d. When prompted, press any key.

5. Restart your computer.
   Log on to the PC and ensure that there are no open programs.

6. Repeat this procedure starting at Step 3.
   If this is the second time reaching this step, you are done.
   The pre-10g Oracle ODBC is now successfully uninstalled.
Installing Oracle 10g - XP/Vista

This section includes:
- Installing Oracle 10g for XP/Vista on page 21

**NOTE:**
Confirm that you have the correct version, from Ex Libris, of the Oracle 10g installation software for your version of Microsoft Windows. The Oracle 10g CD from Oracle cannot be used with this procedure. See Downloading the Installation Packages on page 11 regarding downloading the installation materials that you need.

Installing Oracle 10g for XP/Vista

This section provides installation instructions for the Microsoft XP or Microsoft Vista operating system environments. For Microsoft Windows 7, see Installing Oracle 10g - Windows 7 on page 23.

**To install:**

1. Restart your computer.
2. Log on to the PC and ensure that there are no open programs.
3. Start the Ex Libris automation tool, BEAT.bat, located in C:\Oracle10g\10201_client_win32 (Microsoft XP) or C:\Oracle10g\10203_client_vista-win7 (Microsoft Vista).
4 Install Oracle 10g.
   a Select option 3, Install Oracle 10g Client.

   ![Oracle Client Configurator]

   b When prompted, answer Y to install the Oracle 10g client.

   **CAUTION:**
   Do not attempt to change the window focus during this process.

   c Wait for a message indicating that the installation has completed.

   **NOTE:**
   This may take up to 10 minutes.

   ![Installation in progress]

   d Press Enter to close the install windows.

   e Press Enter to return to the Ex Libris automation tool.

   Oracle 10g ODBC is now successfully installed.
Installing Oracle 10g - Windows 7

This section includes:
- Installing Oracle 10g for Windows 7 on page 23

**NOTE:**
Confirm that you have the correct version, from Ex Libris, of the Oracle 10g installation software for your version of Microsoft Windows. The Oracle 10g CD from Oracle cannot be used with this procedure. See Downloading the Installation Packages on page 11 regarding downloading the installation materials that you need.

Installing Oracle 10g for Windows 7

This section provides installation instructions for the Microsoft Windows 7 operating system environment. For Microsoft XP or Microsoft Vista, see Installing Oracle 10g - XP/Vista on page 21.

**NOTE:**
For the Microsoft Windows 7 version of the installation, there are some manual steps that you need to complete in addition to running the automated tool to install the Vista ODBC drivers on your Microsoft Windows 7 system. Installing Oracle 10g for Windows 7 below describes how to use the Ex Libris automation tool and what manual steps to perform.

**To install:**

1. Restart your computer.
2. Log on to the PC and ensure that there are no open programs.
3. Start the Ex Libris automation tool, BEAT-win7.bat, located in C:\Oracle10g\10203_client_vista-win7.
For the Microsoft Windows 7 environment only, run the BEAT tool as Administrator from the command line as follows:

a. Click **Start > All Programs > Accessories > Command Prompt.**

b. Right click **Command Prompt.**

c. Click **Run as administrator.**

   The command line window opens.

d. Change the directory (cd) to the location of the unzipped files, specifically, the location of the `BEAT-win7.bat` file.

e. Run **BEAT-win7.bat** from the command line.

**IMPORTANT:**

Using this method to run BEAT in the Windows 7 environment is necessary to insure that the BEAT tool is able to access all the files that it needs.

4. Install Oracle 10g.

   Select **option 3, Install Oracle 10g Client.**
The Welcome screen displays.

5 Click Next.

The Available Product Components screen displays.
6 Click Next.

The Product-Specific Prerequisite Checks screen displays.
Chapter 6: Installing Oracle 10g - Windows 7

NOTE:
The operating system version check fails. This is okay. However, you need to select the check box to the right of the highlighted error message (manual check) and click Next to continue with the installation.

7 Click Yes to continue processing when you receive the warning message.

The Summary screen displays with the correct products selected.
8 Click **Install**.

The installation takes a few minutes. A patch is also installed.

The Oracle Net Configuration Assistant: Welcome screen displays.
9 Select the **Perform typical configuration** check box and click **Next**. Another Welcome screen displays.

10 Click **Next**.
11 Click **Finish** when the Oracle Net Configuration Complete screen displays.

12 Click **Exit** when the End of Installation screen displays.

13 Click **Yes** when prompted with the exit warning.
Configuring Oracle

This section includes:

- Before You Start on page 31
- Upgrade Instructions on page 32
- New Installation Instructions on page 33
- Completing the Configuration on page 35

**Before You Start**

If this an upgrade from Oracle 9i and the steps in the Backing Up the Current Oracle Configuration on page 13 were followed, proceed to the Upgrade Instructions on page 32.

If this is a new installation of Oracle 10g, proceed to the New Installation Instructions on page 33.

After either section, continue to Completing the Configuration on page 35.

After completing either the new or upgrade instructions, the PC should have a tnsnames.ora file in C:\oracle\product\10.2.0\client\NETWORK\ADMIN\ with the following stanza:
Upgrade Instructions

To upgrade:

1. Restart your computer.
2. Log on to the PC and ensure that there are no open programs.
3. Start the Ex Libris automation tool (BEAT).
4. Restore TNSNAMES.ORA.
   a. Select option 4, Update tnsnames.ora.
   b. Select option 7, Restore backup TNSNAMES.
Enter Y if you are sure you want to restore.

```
Restoring tnsnames.ora...
Are you sure you want to restore? (Y/N):
```

d  Press Enter to return to the Ex Libris automation tool.

5  Continue to Completing the Configuration on page 35.

New Installation Instructions

To configure a new installation of Oracle:

1  Restart your computer.
2  Log on to the PC and ensure that there are no open programs.
3  Start the Ex Libris automation tool (BEAT).
4  Create a TNSNAMES.ORA.
   a  Select option 4, Update tnsnames.ora.
   b  Select option 1, Add VGER Instance - Voyager.
c Enter the IP Address of your Voyager server.

d Enter Y to confirm when prompted.

e Press Enter to return to the Ex Libris automation tool (the Update tnsnames.ora section).

f Enter option B, Back, to return to the Ex Libris automation tool main menu.

5 Continue to Completing the Configuration on page 35.
Completing the Configuration

To update ODBC Configuration:

1. Select option 5, Update ODBC Configuration.

2. Select option 6, Save and Clear System ODBC Configuration.

**CAUTION:**
Under Windows XP Professional SP2, the option 6, Save and Clear System ODBC Configuration, may remove all System DSNs. Instead of selecting this option, proceed to Step 3.

3. (Alternative) Use the Registry Editor, regedit.exe, to make the following registry changes:
   a. In HKEY_LOCAL_MACHINE\SOFTWARE\ODBC\ODBC.INI\ODBC Data Sources, delete the key-value pair voyager=Microsoft ODBC for Oracle and replace it with VGER=Microsoft ODBC for Oracle.
   b. In HKEY_LOCAL_MACHINE\SOFTWARE\ODBC\ODBC.INI, rename the voyager key to VGER.
   c. Skip to Step 7 to quit the BEAT, and follow Step 8 to make additional registry changes.
4 Select **option 1, Add VGER Instance - Voyager**.

5 Enter Y to confirm when prompted.

6 Press **Enter** to return to the Ex Libris automation tool (Update ODBC Configuration).

7 Select **option Q, Quit**, to quit the Ex Libris automation tool.

8 Open the Registry Editor, `regedit.exe`, and search for **NLS_LANG**.

9 For any occurrences of **NLS_LANG**, change the data value to:
   ```
   AMERICAN_AMERICA.US7ASCII
   ```

Oracle 10g ODBC is now successfully configured.
Prepackaged Reports

This section includes:
- Before You Start on page 37
- Linking Prepackaged Reports on page 38

Before You Start

The procedures for linking tables with different versions of Microsoft Access are similar, but there are some differences. Instructions are provided for both Access 2007 and Access 2003.

Record the following information on Table 1 to use in Linking Prepackaged Reports on page 38:
- Your database name
  For example: xxxxdb
- Your read-only ID and password (usually written as logon/password)
  Username = ro_xxxdb
  Password = ro_xxxdb
  ro_xxxdb/ro_xxxdb
- Database server name or IP address
- Oracle SID
  For Voyager 5.0 or higher, your SID is VGER.
  For Image Server, your SID is VGER.
  For an earlier version of Voyager or Endeavor Heritage Digital Products, contact Ex Libris Global Customer Support.
Table 1. Access for Linking Prepackaged Reports

<table>
<thead>
<tr>
<th>Voyager Database Name:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Read-Only User ID:</td>
<td></td>
</tr>
<tr>
<td>Read-Only User Password:</td>
<td></td>
</tr>
<tr>
<td>Server Name or IP Address:</td>
<td></td>
</tr>
<tr>
<td>Oracle SID:</td>
<td></td>
</tr>
</tbody>
</table>

Contact Ex Libris Global Customer Support if you need assistance with any of this information.

**Linking Prepackaged Reports**

*To link prepackaged reports for Access 2007:*

1. Open the Voyager Access Reports file.  
   This is also referred to as the `Reports.mdb` file.

   **NOTE:**  
   If this file does not exist, confirm that Voyager Access Reports was installed.

   You may see the security warning mentioned in Step e on page 39.

2. Get the external data to initiate the linking.
   a. Click the **External Data** tab.

   b. Specify the ODBC databases. Under the More button, select **ODBC Databases**.
c  Select **Link to data source** by creating a linked table.

The Select Data Source screen displays.

**Figure 29:** The Select Data Source screen displays.

**Figure 30:**

<table>
<thead>
<tr>
<th>Data Source Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dBASE Files</td>
<td>User</td>
<td></td>
</tr>
<tr>
<td>Excel Files</td>
<td>User</td>
<td></td>
</tr>
<tr>
<td>MS Access Database</td>
<td>User</td>
<td></td>
</tr>
<tr>
<td>RTIFULCRUM</td>
<td>System</td>
<td>RTIFULCRUM</td>
</tr>
<tr>
<td>VGER</td>
<td>System</td>
<td>tables</td>
</tr>
</tbody>
</table>

**Figure 31:**

<table>
<thead>
<tr>
<th>Data Source Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dBASE Files</td>
<td>User</td>
<td></td>
</tr>
<tr>
<td>Excel Files</td>
<td>User</td>
<td></td>
</tr>
<tr>
<td>MS Access Database</td>
<td>User</td>
<td></td>
</tr>
<tr>
<td>RTIFULCRUM</td>
<td>System</td>
<td>RTIFULCRUM</td>
</tr>
<tr>
<td>VGER</td>
<td>System</td>
<td>tables</td>
</tr>
</tbody>
</table>

d  Click the **Machine Data Source** tab, select the data source name that matches your Oracle SID, and click **OK**.

The Select Data Source screen displays.

**Select Data Source**

<table>
<thead>
<tr>
<th>Data Source Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dBASE Files</td>
<td>User</td>
<td></td>
</tr>
<tr>
<td>Excel Files</td>
<td>User</td>
<td></td>
</tr>
<tr>
<td>MS Access Database</td>
<td>User</td>
<td></td>
</tr>
<tr>
<td>RTIFULCRUM</td>
<td>System</td>
<td>RTIFULCRUM</td>
</tr>
<tr>
<td>VGER</td>
<td>System</td>
<td>tables</td>
</tr>
</tbody>
</table>

e  Approve the security warning.
The Microsoft ODBC for Oracle Connect dialog box displays.

Enter the read-only user ID, your read-only user password, your Oracle SID, and click **OK**.

The Link Tables dialog box displays.
NOTE:
It may take a few minutes to display.

For Voyager, click **Deselect All** and click **OK**.

For Endeavor Heritage Digital Products, highlight the first through the last table (using SHIFT/Click), click **OK**, and contact Ex Libris Global Customer Support for assistance in completing your installation.
3 Build database links.
   a Under Objects, select the Forms option.

   ![Build database links to Voyager]

   b Double-click **Build database links to Voyager**.
   The Build links to Voyager screen displays.

   c Enter the **Oracle SID for the ODBC Name**, the **Oracle SID for the Connect String**, the **read-only user ID** for DB User ID, the **read-only user password** for Password, and the **Voyager database name** for the Tablespace.

   d Confirm that the Relink check box is selected.
Click Connect.

![Build database links to Voyager](image)

| ODBC Name: | VGER          |
| Connect String: | VGER          |
| DB User ID:   | ro_xxdb      |
| Password:    | **********   |
| Tablespace:  | xxxdb        |

Each table is listed as it is successfully linked. The `ALL_TAB_COLUMNS` table does not link.  

**NOTE:** This is not an error.

Once the tables have completed linking, click **Close**. The prepackaged reports are now successfully linked.

**To link prepackaged reports for Access 2003:**

1. Set the security level.
   a. Start MS Access.
   b. Select **Tools -> Macro -> Security -> Security Level**.
   c. Select the **Low** option.
   d. Click **OK**.
   e. When prompted, click **Yes**.
2 Open the Voyager Access Reports file.

This is also referred to as the Reports.mdb file.

**NOTE:**
If this file does not exist, confirm that Voyager Access Reports was installed.

3 Get the external data to initiate the linking.

   a Select File -> Get External Data -> Link Tables.

   b Specify the ODBC databases by clicking the Files of Type drop-down list located at the bottom of the screen and selecting ODBC Databases.
The Select Data Source screen displays.

c. Click the **Machine Data Source** tab, select the data source name that matches your Oracle SID, and click **OK**.

The Microsoft ODBC for Oracle Connect dialog box displays.
d Enter the read-only user ID, your read-only user password, your Oracle SID, and click OK.

The Link Tables dialog box displays.

**NOTE:**
It may take a few minutes to display.

e For Voyager, click **Deselect All** and click OK.

For Endeavor Heritage Digital Products, highlight the first through the last table (using SHIFT/Click), click OK, and contact Ex Libris Global Customer Support for assistance in completing your installation.
4  Build database links.
   a  Under Objects, select the \textbf{Forms} option.

   \begin{figure}
   \centering
   \includegraphics[width=\textwidth]{chapter8-figure42.png}
   \caption{Figure 42: Build database links to Voyager.}
   \end{figure}

   b  Double-click \textbf{Build database links to Voyager}.
       The Build links to Voyager screen displays.

   c  Enter the \textbf{Oracle SID for the ODBC Name}, the \textbf{Oracle SID for the Connect String}, the \textbf{read-only user ID} for DB User ID, the \textbf{read-only user password} for Password, and the \textbf{Voyager database name} for the Tablespace.

   d  Confirm that the \textbf{Relink} check box is selected.
Click **Connect**.

![Build database links to Voyager](image)

Each table is listed as it is successfully linked.

The **ALL_TAB_COLUMNS** table does not link.

**NOTE:**

This is not an error.

Once the tables have completed linking, click **Close**.

The prepackaged reports are now successfully linked.
Troubleshooting

This section includes:
- First Steps on page 49
- Error Codes on page 50
- Other Possible Errors on page 51

First Steps

When installing the ODBC drivers, make sure that the directory from which you are running the BEAT.bat (or BEAT-win7.bat) file has no spaces or special symbols in it. All of the subdirectories of the ODBC installer hold true to this. As a result, we suggest that you extract the archive downloaded into the root C:\ directory.

The installation process for the ODBC drivers requires certain actions be taken at certain points during the installation. Otherwise, you could run into errors when attempting to link your tables. Thus, it is absolutely necessary that the instructions provided are read through carefully and followed exactly.

If you are running Windows Vista, make sure that you are logged onto your machine as its administrator. When you launch the BEAT.bat installer, select the option to run it as an administrator (available in the context menu).

After the installation is complete and before you link your tables, verify whether or not you can connect to the database by launching a command prompt and typing `tnsping VGER` into the shell. You know it works if, on the last line of the output, you see something like `OK (30ms)`. If you encounter any other errors, consult Table 2 on page 50.

In TNSNAMES.ORA, use an IP address for the host definition. You can use an alias. However, make sure that the host name resolves properly by checking the `/etc/hosts` file on your database server.
If you have trouble linking, examine your TNSNAMES.ORA in comparison to what you have stored on your server in /oracle/app/oracle/product/10.2.0/db_1/network/admin/tnsnames.ora. If your SERVICE_NAME is set to something other than VGER, match that with your local version of the file. This is not always what fixes your problems, but it may help.

**Error Codes**

The table below outlines some of the most common error codes that have been seen during the linking process. If your error is not mentioned here, a good place to search is [http://www.ora-code.com/](http://www.ora-code.com/) which provides you with some helpful insights before you contact support.

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Meaning and Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA-3113</td>
<td>There are issues with network connectivity</td>
<td>Talk to your IT department to confirm that your database server can accept connections over port 1521. It is possible that a firewall is blocking this service.</td>
</tr>
<tr>
<td>ORA-12514</td>
<td>The listener is unable to resolve the host name specified</td>
<td>Check /etc/hosts to confirm that the host name you entered in tnsnames.ora is resolving somewhere. If you are using localhost, confirm that the only definition in /etc/hosts is 127.0.0.1. If you see ::1, comment out this line.</td>
</tr>
<tr>
<td>ORA-12154</td>
<td>Could not resolve the connect identifier specified</td>
<td>There is something wrong with the tnsnames.ora file. Most likely, it is non-existent or the VGER instance is not properly defined. Use the BEAT.bat script to recreate this file.</td>
</tr>
<tr>
<td>TNS-12535</td>
<td>Operation timed out</td>
<td>Your tnsping timed out. Confirm that the IP/alias you are using in tnsnames.ora is correct and can resolve. Confirm that a firewall is not preventing any communications over port 1521.</td>
</tr>
<tr>
<td>TNS-12545</td>
<td>Connect failed because target host or object does not exist</td>
<td>There is most likely a typo in your tnsnames.ora file. Check to confirm that the host is correct.</td>
</tr>
</tbody>
</table>
Other Possible Errors

If, when building the database links in Access, the list of tables linked eventually shows Process stopped, too many errors!, first check the suggestions described earlier. If none of those help, evaluate the response time when performing tnsping VGER. If the time is above 300ms, you may be having network connectivity issues. In this situation, you should talk to your IT staff.

Whenever you attempt to link tables in Access, you should use the read-only user for that specific database. If your database name is exldb, the user name and password would be ro_exldb. If this user is not working for you, a read-only user refresh may be needed.

If linking your tables fails almost immediately because the first six tables produce errors, you may need to refresh your read-only user. To do this, run the readonly.ksh file located in the /m1/utility/ folder. You must be logged in as the oracle user to run this script.